What’s New in Voyager 4.0

Based on Voyager 4.0 Beta, Build 30404, 3/5/08
# Table of Contents

Summary ........................................................................................................................................... 3
Key Changes ....................................................................................................................................... 3
General ............................................................................................................................................... 3
Speed ............................................................................................................................................... 3
Ease of Use ....................................................................................................................................... 3
Power ................................................................................................................................................. 3
Other Changes and Fixes .................................................................................................................. 4
System Requirements ....................................................................................................................... 5
What Isn't Done Yet / Known Bugs .................................................................................................. 5
Moving and Zooming the Chart .......................................................................................................... 6
The Navigator ...................................................................................................................................... 6
Pan (moving the chart) ......................................................................................................................... 7
Rotate ................................................................................................................................................ 7
Zoom .................................................................................................................................................. 7
Tilt ...................................................................................................................................................... 7
The Lower Toolbar ............................................................................................................................. 8
Cmd ................................................................................................................................................... 8
Layout ............................................................................................................................................... 9
Personal Layouts ............................................................................................................................... 10
Chart .................................................................................................................................................. 11
Using Scanned Charts ....................................................................................................................... 12
Customizing Charts .......................................................................................................................... 13
Info .................................................................................................................................................... 14
Weather ............................................................................................................................................ 14
3D ..................................................................................................................................................... 14
GlassView Changes ........................................................................................................................... 15
Update Speed ..................................................................................................................................... 15
Gaugebar .......................................................................................................................................... 15
Gauges ............................................................................................................................................. 15
CDI/Glideslope ................................................................................................................................... 15
Home/Zulu Time ............................................................................................................................... 16
Timer .................................................................................................................................................. 17
Latitude/Longitude ............................................................................................................................ 17
Widgets .............................................................................................................................................. 18
Gauges Widget .................................................................................................................................. 18
NavLog Widget .................................................................................................................................. 18
Airport Info Widget ............................................................................................................................ 19
Chartbar .......................................................................................................................................... 22
Range Indicator/AutoFit ..................................................................................................................... 23
GlassView Toolbar ............................................................................................................................ 24
Direct To .......................................................................................................................................... 24
TAWS and Obstacle Warnings .......................................................................................................... 25
Track Up .......................................................................................................................................... 25
HSI Arc .......................................................................................................................................... 26
Extended Courseline ......................................................................................................................... 26
GPS Centering Lock ......................................................................................................................... 26
Inflight QuickInfo Boxes .................................................................................................................. 27

What's New Voyager 4.0 3/5/08 2
Summary

Key Changes

- 50x faster charting engine. Super-fast pans, zooms, jump to, etc.
- 2D and 3D (HITS)
- Scanned Sectional and IFR charts on the main map. Overlay flight plan line, weather, print, etc.
- Completely redesigned GlassView module.
- Better looking, more modern user interface.
- Faster overall response time.

General

Speed

- Charting Engine 50x faster and draws much more realistic looking charts including terrain with shadows for a more pronounced 3D effect.
- 2D and 3D charts (HITS).
- Generally responds to clicks faster.
- GlassView is faster to use because of many refinements.

Ease of Use

- Choice of digital charts or scanned Sectionals, IFR Low or IFR High anywhere. Mix “digital” and scanned data so you can overlay fuel prices, TFRs, radar/satellite, flight plan line etc. over a scanned Sectional.
- Simplified selection of Layout and Themes.
- New Chart button shows common (not all) themes and makes it easy to customize the chart.
- Chart settings system reduced from two dialogs to one to make it easier to use and more discoverable.
- Larger text and buttons everywhere.

Power

- 3D views (HITS) in both preflight and GlassView.
- New Personal Layouts feature lets you better customize what you see on the screen.
- Many, many new features and refinements, especially in GlassView. These include a Runway Picker, a way to intercept a radial or airway with Direct To, much easier modification of a flight plan while in flight and much more.

GlassView

- Much, much faster! Update speed is once per second rather than once every five seconds.
- Can pan and zoom chart while the plane’s position continues to update.
- Track Up works well no matter how many layers are turned on.
- Super-fast, high resolution TAWS stays below other items on the screen.
- Obstacle warnings. Obstacles turn red when nearby and within 500 ft. A warning message blinks at top of screen when obstacles are within two minutes at current speed.
- New Gaugebar across the top is large and easy to read.
- New Chartbar just below top makes it quick to turn layers on/off without clicking Cmd.
- New Gauges widget shows all gauges, very large, on a tab in most layouts.
• New Timer gauge (both count-up and count-down). Click to toggle on/off or double-click to change count-down time or reset.
• New Current Time (both Home and Zulu) gauge.
• New Lat/Lon gauge. Click to add a Personal Waypoint at that spot.
• Simplified buttons mean no need to click **Cmd** for common tasks or use the Themes menu. Theme selection now under new **Chart** button not under the **Wx** button.
• New CDI/Glideslope gauge.
• New inflight QuickInfo boxes use large fonts to show just the information you need when you click on the Chart. Options include Direct To, Add to FP, Jump To, and more. Can automatically hide after five seconds or stay “sticky” like Post It Notes. Distance/bearing updates every five seconds so you can leave several on screen at the same time to intercept two VORs, etc.
• New **Add to FP (+FP)** feature makes it easy to modify the flight plan enroute.
• Option to show extended courseline.
• New Personal Layouts let you pre-select the range, theme, 2D vs. 3D, etc. for every chart on a Layout. Can set your Personal Layout as the default GV layout
• New Runway Selector lets you pick a landing runway. Adds either a standard VFR pattern (both left and right-handed) or a synthetic (virtual) ILS approach including glideslope. Suggests best runway based on winds. For an ILS, shows standard ILS “feathers” to the runway
• Direct To can intercept a radial or an airway.
• Airport Info widget graphically displays the surface winds relative to the runways. If the airport has no METARs/TAFs, wind info is pulled from nearest airport with winds.
• Can change the planned altitude of a leg enroute.
• Clicking an airport on the Chart does not force the Airport Widget back to the General or Weather tab but keeps it selected on whatever tab was previously selected. Thus, you can quickly check the weather at several airports by clicking each on the chart.

**Other Changes and Fixes**

• Voyager 4.0 includes a new, more modern color scheme.
• When showing general airspace, you can hide TFRs to show the underlying airspace.
• All METARs/TAFs now downloaded all the time, rather than just those along a flight plan line, so there are no more issues with starting a chart at one location, panning far away, and not seeing TAFs/METARs at the new location.
• Fixed: Download AOPA FBO Info.
• Fixed: Problem with downloading some METARs.
• Fixed: Wx color dots on the Nearest widget did not update correctly as time changes and new data is downloaded.
• Fixed: Problem with the TAFs date being decoded incorrectly in very rare instances.
• Default Chart tool is now the Hand not the Pointer.
• For very short displays like the original Samsung Q1 in Landscape mode, the NavLog now hides the Plan area so there is plenty of space for the Waypoints. In this case, a button on the NavLog toolbar (the Up and Down arrows) toggles the display of the Plan area on and off.
• Printing a Chart (the print button above the chart) shows **exactly** what’s on the screen, including the flight plan line.
• New way to delete old and unused flight plans, planes, pilots, etc. from Web Synch. From within the Web Synch dialog box, click **Delete old items from Web Synch**.
• The Chart’s Distance and Bearing tool now shows a circle at the selected range as well as the line so it's easy to see all the points of interest, regardless of direction, a specific distance from a given point.
System Requirements

Voyager 4.0 requires a modern computer running Windows XP or Vista (32 bit only) with a good video card that supports Microsoft DirectX 9.0. 1 GB of RAM is required (2 GB suggested if running Vista). As much as 20 GB of hard disk may eventually be used if you download all scanned charts and all approach plates. No particular CPU speed is required as we’ve seen Voyager 4.0 run well on the Samsung Q1 Ultra with an 800 MHz low-power processor. That said, Voyager 4.0 will run smoother on dual core systems with lots of RAM and good video card. Unlike previous versions of Voyager, the video card is central to the system’s performance.

What Isn’t Done Yet / Known Bugs

- **IMPORTANT!** The Charting system will go offline if the computer goes into sleep, hibernates or **is rotated. Do not rotate tablets while Voyager is running.**
- SmartPlates: Cannot select airports graphically, cannot send to PDA, reports of lockups when downloading plates.
- Drag and drop of flight plan points is currently broken.
- XM. Essentially untested. Some reports say it works fine, others report subtle problems. Also, we had planned to integrate support for XM Winds Aloft into this release but the feature does not currently work and may be dropped from the initial 4.0 release.
- Some routing issues from Voyager 3.6 not yet resolved.
- The integrated Help system has not been updated yet.
- IFR vs. VFR colors not yet supported. VFR colors are currently used for all flight plans.
- Export to handheld Garmin and Lowrance units has not been tested.
- Several minor bugs still exist.
- Multiple problems and undone issues remain with Memory Card Synch. We suggest not using this feature in the beta.
- Reports of a problem with a Dell Optiplex and Intel GMA300 video adapter.
- Various problems when the manual Tilt controls are used to tilt the display from 2D to 3D rather than using the 3D button.
- In GlassView, the two chart layouts (Splitscreen 2 Stacked or Side-by-Side) are somewhat problematic. We think we have all the issues resolved but are still testing.
- As of this writing, not all scanned chart bits have been uploaded to the server. Thus, while scanned Sectionals should be available for all 50 states, Low Altitude and High Altitude scanned chart bits may not be. Also, a reminder that the new scanned chart layer on the main chart does not use the same scanned charts as the Chart Viewer does. At the moment, to download the scanned chart bits for a specific flight, you need to manually pan the chart along the flight while Voyager is connected to the Internet so it can download all the necessary chart bits. There will be an easier way to do this in the shipping version.
- In GlassView 3D (HITS) mode, Voyager displays waypoint idents as well as continually updated distance and bearing information. However, this information is currently hard to read, especially if multiple waypoints fall along the same line of sight.
- Does not work on Vista 64. Vista 32 or Windows XP are required and fully supported.
- Printing may be problematic as we're still testing it.
- Does not work under virtual machines such as VMWare or Parallels. These problems, due to DirectX, will likely persist in the shipping version. Voyager 4.0 runs well on Apple Macs using Bootcamp to run Vista 32 or XP.

What’s New Voyager 4.0 3/5/08
Moving and Zooming the Chart

The most eagerly anticipated new feature in Voyager 4.0 is the all-new charting engine. The new charting engine is based on Microsoft DirectX technology which means that we now leverage the full power of your computer's video card to do essentially real-time 2D and 3D rendering. DirectX is the same underlying system used by Microsoft Flight Simulator, Google Earth and many games.

In previous versions of Voyager, many of the ways you would move, zoom or re-center the chart were based on the charting engine being slow; with the speed of this new charting engine, we re-thought many things and, based many of the new ways to navigate the chart on Google Earth. Thus, if you've used Google Earth, you probably already know how to pan (move), zoom or tilt the chart. However, even if you are, this section is still useful as we changed a few things, relative to Google Earth, to make the system more applicable to flying.

The Navigator

The most obvious new element of the new charting engine is the Navigator. The Navigator is a compass ring with four buttons in the middle, a joystick ball and two sliders. It is very similar to the Navigator in Google Earth. By default, the Navigator is shown in pre-flight planning and hidden in GlassView. Press F12 to toggle it on or off or select Show Navigator from the View menu.
**Pan (moving the chart)**

Gone are the "scroll buttons" of previous versions. Now just use the Hand tool (which is now the default Chart tool -- not the Pointer) to pan. You can also use the center button (the joystick) of the Navigator to move in any direction or use the four directional buttons.

**Rotate**

Click and drag the "ring" portion of the Navigator and spin. Double-click on the ring to reset to North.

**Zoom**

There are many ways to zoom the chart.

- Click and hold the magnifying glass + and - icons on the chart toolbar. **Note:** On a tablet, this only works to a point before Windows decides that you really meant a right-mouse click and stops the zooming.
- Press Ctrl and + or -. The cursor Up and Down keys also change the zoom. This feature is disabled while in GlassView.
- Use your mouse wheel.
- Use the Range box to select from any predefined range or type anything you want and press the Enter key.
- Right click on the chart and use the Center At and Zoom choice to center on a point and zoom.
- Switch to the Pointer tool and click and drag to zoom to an area.
- Use the + and - or slider to the right of the Navigator wheel. Use the + and - buttons to quickly zoom or move the slider away from the center to smoothly control zoom speed.

**Tilt**

Click the 3D button on the lower toolbar to toggle quickly from 2D to 3D or vice-versa. The behavior varies a little depending on what you're doing. In pre-flight planning mode, with a flight plan, going into 3D mode brings the "eye" to the altitude implied by the point in the flight. In other words, if the chart timeline is set to halfway into the flight, the altitude set when entering 3D mode is your cruise altitude while pressing 3D while the timeslider is at the start of the flight, brings the altitude to the elevation of your takeoff airport. If you're looking at weather or otherwise have no flight plan, 3D mode will begin at your default planning altitude. If you're in GlassView, the altitude is determined by the GPS or GPS Simulator.

Alternately, you may also use the Up and Down arrow buttons above the Navigator to change the pitch from straight down (2D) to full 3D or anywhere in between. Double-click either of these buttons to reset to 2D view.

In 2D mode, flight plan segments are shown as lines; in 3D, they are shown as a series of boxes spaced 2 NM apart. In 3D, most chart layers are not currently shown; terrain is the primary 3D layers with airspace and METARs/TAFs shown but at ground level. Future versions of Voyager will display more layers in 3D.
The Lower Toolbar

At the bottom of every flight plan, GlassView or Chart window is a new toolbar with large, easy to hit buttons for common tasks and set of tasks. In many cases, the same functions, and more, are available from the menu at the top of the screen but the lower buttons show just the commonly used functions, making them easier to use in most cases.

Cmd

The Command (Cmd) button toggles between Voyager displaying simplified or detailed information. When Cmd is off, the system generally shows fewer options than with Cmd on. For example, when Cmd is on and the system is in preflight mode, the chart displays a small toolbar with layers to turn on and off, a timeline and an altitude slider. When Cmd is off, these are all hidden to give more room to the chart itself. By default, Voyager begins preflight planning mode with Cmd on when running on screens larger than 1024 x 768 and off for smaller screens. Cmd always begins off with GlassView. In GlassView, to keep taps on the screen from inadvertently changing the flight plan, you can only drag and drop flight plan points when Cmd is on.

Note: In previous versions of Voyager, the Cmd button was used extensively to get to common functions, especially in GlassView. In Voyager 4.0, this is not necessary since all such previously hidden options are shown. Thus, while there are still some uses for Cmd, it is seldom necessary any more.
Layout

As with previous versions of Voyager, the Layout button shows other screen configurations ("layouts") that you can switch to. However, in Voyager 4.0, most of the less-commonly used layouts are hidden, by default, to reduce screen clutter. In addition, many of the layouts from previous versions have been altered and/or renamed for better clarity. For example, the GlassView Combo 1 layout, designed for large screen displays, is now called Widescreen. See the Layouts section for more information about each layout. By default, the Layout button only shows layouts suited for your display. For example, if you're using a Tablet PC in portrait mode, Voyager hides the Splitscreen 1 (Side by Side) and Splitscreen 2 (side by side) layouts in favor of showing the Splitscreen 1 (Stacked) and Splitscreen 2 (Stacked) layouts. You can always select any layout by selecting Layouts from the View menu at the top of the screen. In addition, you can choose which layouts you want hidden and which shown, when the Layout button is clicked, by selecting Layouts from the View menu and clicking Customize.

By default, Voyager shows the following layouts (assuming you have all Voyager modules):

- **NavLog and Chart**: Preflight. Shows just the NavLog and Chart widgets.
- **Standard Flight Plan**: Preflight. As above but also adds the Profile widget.
- **Splitscreen 1 (side-by-side)**: GlassView, Landscape-mode screen. Shows two columns of widgets, each with several tabs. The left column has a Chart widget while the right column has all the other available widgets.
- **Splitscreen 2 (side-by-side)**: GlassView, Landscape-mode screen. As above but adds a second Chart to the right-side column and moves the Procedure to the left column.
- **Splitscreen 1 (stacked)**: GlassView, Portrait-mode screen. Shows two rows of tabbed widgets. The top row has just the Chart widget and the bottom row has all the other GlassView widgets.
- **Splitscreen 2 (stacked)**: GlassView, Portrait-mode screen. As above but adds a second Chart to the bottom row of widgets and moves the Procedure widget to the top row.
• **Tabs.** GlassView. Shows all inflight widgets on a series of tabs. Excellent for tablets with small screens or when you want the largest Chart possible.

• **Widescreen.** GlassView. Similar to Splitscreen 1 (*side by side*) but with a slightly different widget configuration that works well for large displays.

**Note:** As the layouts have changed significantly in this release, the Default GlassView Layout (in Tools/Options/Defaults) is reset to Auto. With Auto, Voyager selects the best GlassView layout for your computer’s screen size and orientation. You may select Options from the Tools menu to change this to any specific layout you prefer. This includes Personal Layouts, described below.

### Personal Layouts

Voyager 4.0 also introduces a very powerful new concept, the **Personal Layout.** As the name implies, a Personal Layout is layout that you’ve created for your specific needs. Technically, a Personal Layout is more than a layout; it’s really an encapsulation of standard layout and theme settings plus other options. That is, a Personal Layout can, with two clicks, change the base layout, change the Theme on each of the two charts, change the zoom range of each chart, turn TAWS (for GlassView) on or off, etc. You can name your Personal Layouts and assign icons to them for quick identification. Select **Customize Layouts** from the Layout button to create or edit a Personal Layout.

A personal layout is very flexible. It may contain a specific layout or leave the layout as it is. It may specify, for each Chart that is part of the layout, a specific theme and/or range or leave either unchanged as well as whether the Chart is 2D or 3D (HITS). In addition, for GlassView, where Personal Layouts are most convenient, a Personal Layout specified whether or not to show the Gaugebar and/or Chartbar and, again for each Chart, whether to orient as Track Up (as opposed to North Up), to show the HSI arc, to show the extended courseline and whether TAWS (terrain warnings) are enabled. These features are described in detail in the GlassView section below.

**Tip:** Especially for GlassView, if you’ve setup a screen exactly how you like it in terms of the layout, the theme(s), the zoom level, etc., click the **Save Layout Settings** choice from the Layouts button. If you’re not currently using a Personal Layout, Voyager will create one based
on the current settings. If you are already using a Personal Layout, the settings of that layout will be redefined using whatever settings are on the screen.

**Chart**

The Chart button at the bottom of the screen shows common themes and makes it easy to customize the chart. To switch to a theme, simply click **Chart** to select the theme you want. By default, Voyager hides some of the less common themes to keep things simple. In addition, Voyager defaults to hiding themes that apply to high-altitude aircraft when the flight plan is for a low-altitude (under 18,000 ft. service ceiling) aircraft. You can choose to show any theme normally hidden by selecting **Edit** from the **Themes** menu at the top of the screen then choosing the theme and clicking the **Edit** button. Check **Common theme** for the theme to be shown when **Chart** is clicked. You can also change the icon associated with each theme in this way.

The following themes are shown by default. Voyager also shows any theme that you've defined.

- **Fuel Prices (AvGas).** Shows a simplified theme that mainly displays airports that have AvGas.
- **Fuel Prices (JetA).** Only shown when a high-altitude aircraft is selected. As above but with JetA.
- **IFR Enroute Low (Digital).** Shows a digital (vector) version of a standard IFR low chart plus terrain. Note: Click the Terrain button on the Layers toolbar or the ChartBar to turn the terrain off and see a white chart.
- **IFR Enroute Low (Scanned).** Shows the scanned FAA Low Altitude Chart plus timely digital data including fuel prices and TFRs.
- **IFR Enroute High (Digital).** Only shown when a high-altitude aircraft is selected. Shows a digital (vector) version of a standard IFR high chart plus terrain. Note: Click the Terrain button on the Layers toolbar or the ChartBar to turn the terrain off and see a white chart.
- **IFR Enroute High (Scanned).** *Only shown when a high-altitude aircraft is selected.* Shows the scanned FAA High Altitude Chart plus timely digital data including fuel prices and TFRs.

- **Sectional (Digital).** Shows a digital (vector) version of a standard Sectional chart

- **Sectional (Scanned).** Shows the scanned FAA Sectional Chart plus timely digital data including fuel prices and TFRs.

You can create your own themes by setting up a chart the way you like then selecting Edit from the Themes menu at the top of the screen. Use the Add button to create a new one and Edit to modify an existing one. You can also get to that dialog box via the Themes button on the Customize Charts dialog box shown below.

**Note:** Most of the themes used by previous versions of Voyager have been renamed or removed for better clarity. In addition, custom themes that you may have created are also not carried forward to Voyager 4.0 for technical reasons. Similarly, Voyager 4.0 resets the Default IFR Theme and Default VFR Theme (in Tools/Options/Defaults) to IFR Enroute Low (Digital) and Sectional (Digital), respectively.

### Using Scanned Charts

Previous versions of Voyager included a feature called the Chart Viewer that shows an entire FAA scanned charts, exactly as printed. You must select which chart to view and Voyager displays or downloads it if necessary. Voyager 4.0 still includes this feature but also includes a powerful new feature that allows scanned charts to be integrated into the main chart area. In the main chart area, scanned charts may have flight plan lines, weather, TFRs, fuel prices and more overlaid on them.

The new scanned layer in Voyager 4.0 downloads scanned charts in small pieces and seamlessly combines the 'bits' from multiple charts. Similar to using Google Earth, when Scanned Sectionals are turned on, Voyager downloads and displays the required 'bits' of Sectional from whichever FAA Sectionals are required. That is, there is no need to specify which Sectional to use.

Scanned Charts are turned on by selecting a predefined theme designed for scanned charts. These include **Sectional (Scanned), IFR Low Altitude (Scanned), and IFR High Altitude (Scanned).** These charts combine the appropriate scanned chart bits plus some digital data including TFRs and fuel prices. You may also combine any other digital data with the scanned chart, most typically NexRad Radar, Cloud Tops (Satellite), etc. Use the Layers Toolbar or the ChartBar (GlassView) to add the digital layers. You may also begin with any other theme and click the Scanned Charts icon to add a scanned layer. Right-click the Scanned Charts icon to select which type of scanned chart (Sectional, IFR Low Altitude, or IFR High Altitude) to display.

The chart ‘bits’ used by the new Scanned Charts feature are not derived from the full scanned charts downloaded for the Chart Viewer; they must be downloaded separately. The Chart Viewer's Download Manager can, however, be used to download just the full Scanned Charts and/or the matching chart bits.

**BETA NOTE:** The Download Manager in this beta cannot download Chart Bits. To see scanned Sectionals or IFR Charts in the main chart window, it's necessary to pan and zoom the chart over the areas of interest and allow Voyager to download the bits.
Customizing Charts

In addition to using the Layers toolbar or the ChartBar (described in the GlassView section) to turn layers on or off, you can customize many details about most layers. For example, you can change the zoom range at which Class B airspace becomes visible or whether NDBs are shown when you turn on Navaids. With previous versions of Voyager, changing these details required selecting Customize Chart then clicking an Advanced button. With Voyager 4.0, the “Advanced” dialog box and the “Standard” Chart Customize dialog box have been combined for faster access and better discoverability. To change any chart setting, select Customize Chart from the Chart button. Within the Customize Chart dialog box, double-click the green and red dots on the left side to turn a layer on or off (green is on, red is off) or check the Show checkbox. For layers with options, selecting a layer from the left-side list shows its options.

Tip: In previous versions of Voyager, the range at which different chart elements appeared was often called the Minimum Range. This was misleading as the value was actually the largest (maximum) range at which the layer would be shown. If the zoom was larger (that is, further back or less zoomed), the layer would be hidden. Thus, for Voyager 4.0, the system uses the term Maximum Range where older versions would have said Minimum Range.

In previous versions of Voyager, it was sometimes confusing whether chart changes would “stick” when you switched themes and such. In Voyager 4.0, chart settings are not saved unless you specifically save them by selecting Save Chart Settings from the Chart button. Saving Chart settings means saving which layers are turned on and, for each layer, which sub-options...
are enabled and at which zoom level. In other words, everything in the dialog box above. The zoom (or range) setting of the current chart is **not** part of what is saved. You can save a more complete screen configuration, including all these layer settings, zoom levels, layouts, etc. by creating a **Personal Layout** as shown in the **Chart** button notes above.

**Info**

Click the **Info** button to get information, at any time, about any airport, nav aids, etc.

**Weather**

The **Weather** button is mostly unchanged from the previous versions of Voyager except that themes previously listed there that were unrelated to weather have been removed. Use the **Chart** button to select a new chart theme.

**3D**

As described above, this button toggles between standard 2D view and a 3D, Highway-In-The-Sky (HITS) view.
GlassView Changes

Voyager's GlassView module has been dramatically enhanced in version 4.0. In general, the changes are much faster chart update speed, faster response time to user clicks, larger text and buttons and fewer clicks for common tasks. It also adds a considerable number of all-new features.

Update Speed

Previous versions of Voyager updated the aircraft's location every five seconds on all widgets. Voyager 4.0 updates the Chart and Gauges once every second (charts update every other second, per chart, for layouts with two charts). To keep the chart update speed fast, other widgets generally update less frequently, typically once every five or 10 seconds. There is no perceptible performance difference in GlassView 4.0 regardless of which chart layers are turned on, whether the system is in Track Up or North Up mode or whether TAWS is on or not. 2D and 3D modes are also equally fast.

Gaugebar

In previous versions of GlassView, the gauges (indicators for groundspeed, altitude, next waypoint, etc.) shared space on the bottom of the screen with a toolbar. While this arrangement saved screen space for larger charts, the gauges were often too small to be easily read and there wasn’t enough space, especially when in portrait-mode, for many gauges.

Voyager 4.0 includes a new, large, Gaugebar at the top of the GlassView screen. Conceptually it’s similar to old set of gauges but the text is generally larger.

The Gaugebar can be turned on or off by selecting Show Gaugebar from the View menu. It can also be turned on or off as part of the settings in a Personal Layout (above).

Gauges

A gauge shows important flight information. Voyager includes more than a dozen different gauges so not all can fit on the screen at once. Generally, you can add, remove or re-arrange gauges by clicking on any gauge or on the blank space next to the gauges although some gauges have specific responses to a click that override this behavior. These are described below.

Voyager 4.0 includes many new gauges.

CDI/Glideslope

One of the most requested new gauges is the CDI/Glideslope gauge. It shows deviation from the course line and vertical information about the glideslope or deviation from the desired altitude. The system works in either IFR or VFR modes.

In IFR mode, the gauge shows a standard cross-hair with vertical and horizontal lines. Much like a Garmin GPS CDI, the CDI shows distance from the flight plan or Direct To line, not the angular differential from a VOR radial.
The CDI and Glideslope are command-style gauges, meaning that they indicate the direction to fly to reach the desired track or altitude rather than show how far off you are from the track. That is, when the CDI vertical line is to the left of the centerline, you need to fly to the left; when the line is to the right, you need to fly right.

The CDI sensitivity varies depending on your distance from the next waypoint. If the distance to the next waypoint is more than 30 NM, full-deflection to one side is 5 miles. At 30 NM, full-deflection is 1 NM. Within 2 NM, full-deflection is just .3 NM.

The Glideslope indicator works in two modes. When you’ve used the new Rwys button on the Airport Info widget (described below) to select a specific runway, and you’ve chosen a Synthetic ILS approach, the Glideslope gauge uses the published glideslope for the selected runway. If the runway has no published glideslope, the system assumes a 3% glideslope.

When not approaching a runway, the Glideslope indicator gives vertical guidance about distance from the desired altitude relative to the end-altitude of the current waypoint. Full-deflection is 1000 ft. Thus, during cruise, the GS will indicate whether you should go up or down to reach your desired cruise altitude. When the line is above the centerline, you should fly up; when the line is below the centerline, you should fly down.

**Important:** In cruise-mode, the GS does not track a takeoff or landing angle. Rather, it gives guidance relative to the final altitude for that leg. That is, during takeoff, if you are aiming for an 11,000 ft cruise altitude, the gauge will indicate that you need to fly higher until you reach 11,000 ft, even if you are above the implied departure angle. Similarly, during a VFR landing, the indicator will always read that you need to go down until reach landing. Actual glideslope guidance is only provided during a Synthetic ILS approach.

The CDI/Glideslope also works in a VFR mode. In VFR mode, arrows are substituted for lines. Between one and three arrows, pointing in the appropriate direction to fly, are used in place of the lines. Thus, if you need to fly just a little to the right, you’ll see one arrow to the right. If you need to fly far to the right, you’ll see three arrows pointing to the right. Vertical guidance is similar, using between one and three arrows pointing up or down where up arrows mean you need to climb and down arrows mean you need to descend. The sensitivity is the same whether in VFR or IFR mode.

The CDI/Glideslope gauge defaults to either IFR or VFR mode depending on your flight plan or, if no flight plan, you default flight mode as specified in Tools/Options/Defaults. Click the CDI/Glideslope to manually toggle between IFR and VFR modes.

**Home/Zulu Time**

The new Home gauge shows the current time, as indicated by your computer’s clock. The new Zulu time gauge shows the current Zulu (UTC) time.
**Timer**

Voyager 4.0 includes two timers, Timer1 and Timer2. Both can be configured as either count-up (chronometer) or count-down (timer). The count-down mode is especially useful for switching fuel tanks at regular intervals. Each timer begins as a count-up timer. Click a timer to start or stop it unless it’s a count-down timer that has reached zero, in which case a click restarts the timer from the last count-down value. Double-click a timer to toggle between count-up to count-down and, for count-down, to set the desired elapsed time.

![Timer Configuration Window](image)

In the timer configuration window, you can also tell the count-down timer to signal when it reaches zero by either an audible alarm (which could be hard to hear in the cockpit) and/or a visual alarm (a message box). Even if neither alarm mode is selected, a count-down timer will turn bright red when it reaches zero. In addition, if the timer is on the Gauge widget (as opposed to the Gaugebar, see Widgets, below), the Gauge widget will come to the front when a timer on it reaches zero.

**Latitude/Longitude**

The Latitude/longitude widget shows the current GPS latitude/longitude in the format specified in **Tools/ Options/ Units**. In addition, this gauge is handy for photographers, CAP pilots and other pilots who need to periodically record the latitude/longitude of a point. Clicking this gauge asks if you want to create a Personal Waypoint at the current GPS location.
Widgets

Voyager 4.0 adds a new Widget, the Gauges widget, as well as adds features to several existing widgets. Also, as described in the Layout button section above, Voyager 4.0 has many new and modified layouts that make better use of the widgets.

Gauges Widget

<table>
<thead>
<tr>
<th>GS</th>
<th>77</th>
</tr>
</thead>
<tbody>
<tr>
<td>WPT</td>
<td>SEA</td>
</tr>
<tr>
<td>DIS NM</td>
<td>32.1</td>
</tr>
<tr>
<td>ETA</td>
<td>05:09</td>
</tr>
<tr>
<td>TMR</td>
<td>00:16+</td>
</tr>
<tr>
<td>ALT</td>
<td>12240</td>
</tr>
<tr>
<td>DTK</td>
<td>121°</td>
</tr>
<tr>
<td>ERE</td>
<td>00:25</td>
</tr>
<tr>
<td>VOR FR/N</td>
<td>-50</td>
</tr>
</tbody>
</table>

The new Gauges widget is a super-sized version of the Gaugebar. It shows the same type of gauges that are available in the Gaugebar but is completely independent of the Gaugebar so you can show different gauges and in a different order than on the Gaugebar. Gauges displayed in the Gauges widget are also substantially larger than the ones on the Gaugebar so can be useful for smaller tablets. Timers on the Gaugebar and timers on a Gauges widget operate independently. The Gauges widget is available on most of the new tabbed layouts.

NavLog Widget

Clicking a point on the NavLog brings up a dialog box ways to modify the flight plan. Two new buttons were added.

- **Change altitude** changes the planned altitude of a leg.
- **Clear prior wpts** clears all waypoints before the selected point and sets the selected point as the Direct To point.
Airport Info Widget

The Airport Info widget is not new but has a number of important new features and subtle changes. In terms of subtle changes, you may notice the fonts a little larger in the **Comm** and **Nav** areas, especially when the Airport Info widget is larger than usual and Voyager does not automatically switch to the **Weather** or **General** tab when an airport is clicked on. Rather, the Airport Info widget stays set to whichever tab was set previously. This is useful, for example, when quickly clicking on multiple airports to see the weather at each airport.

**Surface Winds**
Voyager 4.0 shows the direction and velocity of surface winds at each airport, displayed over the runway diagram. Click the runway diagram to toggle the wind display on or off. If an airport doesn’t have its own TAF or METAR, Voyager finds the nearest airport with the appropriate information and uses that instead.

**METAR and TAF Information Available Full-Screen**
As before, Voyager shows extensive METAR and TAF information for the selected airport under the **Weather** tab. If the airport does not have its own METARs and/or TAFs, Voyager finds the appropriate report from the nearest airport.

On some displays, the METAR and TAF information may be hard to read. Voyager 4.0 includes the new ability to see this information in a full-screen window with very large fonts. Simply click the METAR or TAF text to see it in the full-screen window.
+FP button
Previously the Airport Info widget had a Direct To button that made this airport the next waypoint. That is now joined by a +FP (Add to Flight Plan) button that adds this airport to the place you specify within the flight plan. That is, if you’re halfway into a flight and want to add a refueling stop, use +FP to put the landing airport in the correct sequence within the flight plan. Clicking the Clear the plan then add this waypoint button can also be used to begin a new flight plan, starting with this airport. Insert and clear prior waypoints inserts the new waypoint before another point then clears all previous waypoints to simplify the plan.

Rwy button
The Rwy button is a powerful new feature that makes it easy to select the appropriate runway for best winds and adds either a standard VFR landing approach or a synthetic (virtual) ILS approach.

As this button adds multiple points to the flight plan, an airport must be on the flight plan before Rwy can be used. If the airport is not on the flight plan, Rwy will ask if you want to add it to the end. Tip: To add the airport somewhere other than the end, use the new +FP button first then click Rwy.

When Rwy is clicked, it selects the best runway given the expected surface winds. In the case of multiple runways having equally advantageous winds (or light and variable winds or no wind...
data available), Voyager generally selects the longest runway. However, in the case of an IFR flight and no deciding wind data, Voyager picks the longest runway with an ILS. Regardless of what Voyager chooses, you can pick any runway you like with the Runways list.

In addition to selecting a runway, you can specify the type of approach. The three choices are a IFR (Synthetic ILS), VFR (Standard VFR pattern) and None (Just add the runway) (no pattern or approach). Voyager defaults to IFR (Synthetic ILS) for IFR flights and VFR (Standard VFR pattern) for VFR flights.

When a synthetic ILS is selected, Voyager chooses the S-IAF (Synthetic Initial Approach Fix) location and altitude based on the published glideslope (or 3% if there is none) from 5 NM away. When this type of approach is selected, the glideslope information is available to the CDI/Glideslope gauge to provide proper landing glideslope guidance. In addition, Voyager displays standard ILS runway feathers to this runway.

**Note:** When Voyager calculates a flight plan, it uses the descent profile of the selected aircraft to determine when to start descending, not the glideslope. Thus, when the Rwy button calculates the correct altitude at which to begin a descent at the proper glideslope, the flight plan line will not reflect the same angle. This is most apparent when using the built-in GPS simulator as it will follow the flight plan, not the glideslope.

When a VFR pattern is selected, Voyager computes the pattern at the published pattern altitude or, if not provided, at 1000 ft. AGL from the airport, taking into consideration whether the runway is left or right pattern. Entry is on the 45 degree to the downwind leg. The downwind leg is computed as ½ NM from the runway and the distance from final to landing is also ½ NM.

The third option, *Just add the runway*, simply adds the runway to the flight plan without adding a pattern or IAF.

**Important:** Voyager makes no attempt to avoid terrain, obstacles or airspace when computing the S-IAF or pattern so pilot discretion is highly advised.

If you change runways or approach types for a given airport, Voyager removes the ‘old’ pattern before adding the new approach.

**Jump To button**
Clicking Jump To forces Voyager to center the chart over the selected airport. You may be asked if you want to disengage GPS centering.

**Diagram button**
**Note:** This button was previously called Airport Diagram.

Clicking **Diagram** shows the FAA airport diagram (taxiway diagram) for the selected airport. If a Procedure widget is available (as it is on most layouts), the diagram is displayed there. If not, the diagram is displayed in a full-screen window. The FAA provides diagrams for a small subset of all airports but includes most Class B, C and D airports.

**FBO button**
The new FBO button shows the AOPA FBO Information about the selected airport in a full-screen window. The FBO information must have been previously downloaded.
**Tip:** To download all FBO information for every airport along your route, select Download Airport Information from the Plan menu and ensure that FBO and services information is checked.

**Chartbar**

Turning a chart layer on or off in previous versions of Voyager required clicking the Cmd button then clicking a small icon on the Layers toolbox. In version 4.0, the new Chartbar, just below the Gaugebar, is always on and has icons that are four times the size of the icons in the Layers toolbox, making toggling layers much easier.

In addition, turning a layer on with the Chartbar behaves slightly differently than when turning a layer on with the Layers toolbox. Specifically, the Layers toolbox may turn on a layer but sub-settings within that layer may mean that little or no additional information shows up. That is, if you turn on a layer but the **Maximum Range** setting is below your current zoom, nothing will show up (e.g. you’re looking at a zoom range of 150 NM and turn on Nav aids. You may not see anything because the Range associated with Nav aids is 100 NM.). On the contrary, the Chartbar, as it’s designed strictly for inflight use, assumes you won’t have time to deal with the subtleties of Range settings. Thus, when a layer is turned on via the Chartbar, Voyager adjusts the Range as necessary to ensure that common features of that layer show. That said, in that case, Voyager sets the internal **Maximum Range** to slightly greater than the current range. Therefore, if you zoom out, the layer may disappear even though the icon will still be on. In that situation, toggling the layer off then back on resets the Minimum Range such as to show the layer.

The button to the far right on the Chartbar is a shortcut to the Customize Chart dialog box.

The Chartbar adds scroll arrows on the left or right if the screen is not wide enough to show the entire Chartbar.

In Voyager 4.0, changing settings via the Chartbar or the Layers toolbox are not saved automatically. Select **Save Chart Settings** from the Chart button if you make a change that you’d like applied to the current theme.

The Chartbar can be turned on or off by selecting Show Chartbar from the View menu. It can also be turned on or off as part of the settings in a **Personal Layout** (above).
Voyager 3.x indicated the current range by an indicator attached to the HSI arc. Clicking the range produced a menu with available ranges. Voyager 4.0 improves on this in many ways.

- The Range indicator is now in a fixed position on the screen and not related to the HSI arc, making it easier to find.
- To the left and right of the range are zoom in and zoom out, respectively buttons. Click and hold them to smoothly zoom in or out. Note: On many Tablet PCs, holding the stylus or your finger in one spot for more than a few seconds may be interpreted by Windows as a right-mouse click rather than a click and hold. This may limit the usefulness of the zoom in/out buttons for such tablets.
- In addition to specific ranges, the range menu now includes three choices for automatically zooming the chart. The first of these, AutoFit All, works exactly like the AutoFit All option in preflight mode in that it sizes the chart such as to show all waypoints. The second, AutoFit Remaining is typically more useful in flight because it ignores any waypoints already passed, generally allowing the chart to be more zoomed-in. The final option, AutoFit to Wpt, may be the most useful of all as it sizes the chart for maximum possible zoom for showing the distance between your current position and the next waypoint. Note: This is a one-time, not continual zoom. Once AutoFit to Wpt is clicked, Voyager will not continue to zoom-in as you approach the waypoint, subject to the caveat below.
- In 2D mode, Range is the distance, in NM, from the center of the chart to the nearest side. In 3D mode, Range displays Altitude MSL.

In addition to these manual zoom options, Voyager automatically zooms-in when approaching a landing airport. When this option, which is on by default, is engaged, Voyager increases the zoom as often as every 30 seconds such as to maximize the size of the chart. To minimize visual jarring, Voyager only zooms when the difference between the current zoom and the new zoom is at least 20%. This feature can be disabled via a setting in Tools/Options/Preferences/GPS.
**GlassView Toolbar**

When any flight plan or chart is open, in either preflight or GlassView mode, Voyager displays a large toolbar with common commands. During GlassView, this toolbar has additional icons specific for inflight use. For brevity, this section will only mention those functions specific to GlassView; see the Lower Toolbar section above for information about the Cmd, Layout, Chart, Info, Wx and 3D buttons.

**Direct To**

Direct To is a basic GPS function that sets the next waypoint to a specific point, typically a navaids, airport, etc. When the Direct To button on the lower toolbar is clicked, Voyager displays a dialog box that lets you enter any airport, navaids or fix ident or pick from a list of such nearby items. In Voyager 4.0, this dialog box comes up much faster than with previous versions.

In addition, the Voyager 4.0 Direct To dialog box has been enhanced in a number of ways.

- You can go Direct To an airway, either by flying a specific course or by letting Voyager select the nearest intercept point. Use the **Airways** tab to select nearby airways. If required, select the magnetic bearing to follow by using the new **Alt/Radial/Bearing** selector set to **Bearing** and using the numeric keypad to enter the bearing.
- When selecting a navaids, you may optionally specify a radial to intercept. This the From radial. Set the **Alt/Radial/Bearing** selector to **Radial** and use the numeric keypad to enter the bearing.
- If you select a waypoint not currently on the flight plan or appear to be short-circuiting the flight plan or your current position is substantially off the flight plan line, Voyager creates a second line from your current position to this waypoint. The flight plan is left on the screen for possible later use. On the other hand, when you appear to be essentially following the flight plan, no additional line is drawn.
In previous versions, you could enter multiple idents in the Direct To dialog box and Voyager asked if you wanted to create an entirely new flight plan from just those idents. In Voyager 4.0, this has been substantially expanded via the use of the +FP button, explained below.

+FP vs D->. In previous versions of Voyager, Direct To was, literally, Direct To a specific waypoint. Voyager 4.0 still works that way if you select a waypoint then click the D-> button. However, you may now click +FP instead of D->. As with the +FP (Add to Flight Plan) feature in the Airport Info widget, clicking +FP brings up a secondary dialog that asks where within the flight plan you’d like to sequence this new waypoint. In addition, the Add to Flight Plan dialog makes it easy to clear the flight plan then begin with the selected waypoint. See the Add to Flight Plan discussion above for more information.

**TAWS and Obstacle Warnings**

Previous versions of Voyager had a TAWS feature. Voyager 4.0’s is different in that it turning TAWS on or off makes no difference to system performance. Also, the TAWS in previous versions put the red and yellow colors above other layers; in Voyager 4.0, TAWS on simply changes the color of the terrain, which is below the other layers.

The definition of the colors is also somewhat changed. With Voyager 4.0, terrain becomes red when the GPS indicates your position within 300 ft. or below the terrain (it was 100 ft. in Voyager 3.x). Terrain becomes yellow when your position is within 1000 ft. of the terrain.

Voyager 4.0 also introduces obstacle warnings. When the Obstacle layer is turned on, obstacles flash red when the GPS indicates clearance of less than 500 ft. from the top of the obstacle. In addition, Voyager flashes a red warning message at the top of the screen if:

- The GPS-derived course is +/- 15 degrees of an obstacle
- The obstacle is within 500 ft. of the current altitude
- The obstacle would be hit in two minutes or less at the current speed.

The obstacle warning system functions so long as the Obstacles layer is turned on; there is no need to engage TAWS.

**Track Up**

Previous versions of Voyager operated in either Track Up or North Up mode. However, performance was substantially affected by Track Up mode. In Voyager 4.0, there is no performance difference between Track Up and North Up.
HSI Arc

Voyager 4.0 includes the same type of HSI arc as Voyager 3.x. The HSI arc works in both 2D and 3D mode.

Extended Courseline

Sometimes, especially when you’re trying to come close to but not encroach upon airspace, it’s useful to show an extension of the courseline. Clicking this button shows a line, in 2D only that extends 50 NM from the aircraft’s current position, based on the ground track.

GPS Centering Lock

Previous versions of Voyager allowed you to move the chart while inflight but only if the GPS was temporarily disabled. In that case, Voyager stopped updating the aircraft’s position and stopped updating the gauges. In Voyager 4.0, neither of these is true anymore. When panning the chart, the aircraft continues to move on the chart but the chart will not automatically center on the current location. To re-engage centering, either turn this button back on or click the text message at the top of the chart that indicates that centering is off.
In Voyager 3.x, clicking on the chart brought up a dialog box with information about that point but the information was better formatted for preflight rather than inflight use and the system took a relatively long time to process as it brought up almost every piece of related information about that point.

Voyager 4.0 includes all-new QuickInfo boxes that come up very fast and have just the information you need for inflight use. They also use large fonts and have buttons useful inflight such as Direct To, Add to FP (Add to Flight Plan), and Jump To (centers the chart on that point).

The new QuickInfo boxes show the distance and bearing to and from the selected point. This information updates every five seconds so long as the QuickInfo box is open. QuickInfo boxes are not modal, meaning that you can still click and otherwise use Voyager even when a QuickInfo box is shown. You may have as many QuickInfo boxes open at the same time as you like. This is useful, for example, for intercepting specific radials from two different VORs.

QuickInfo boxes generally stay on the screen until Close or More Info is pressed. When Automatically close after 5 seconds is checked, the QuickInfo box stays on the screen for five seconds after all the information is first displayed then closes itself.

Clicking the main text area (in the example above, the area that shows SEATTLE (SEA, US)) shows a full-screen window with the same information, only much larger. This is especially useful when this area shows SUA or TFR airspace with important text information that may not fit in the relatively small area of the QuickInfo box.